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Photoshop Basics for Artists
January 2021

| consider the camera & editing tools like Photoshop & Lightroom to be very
valuable tools for the artist.
As long as we don’t become slaves to copying mechanically what is in front
of us. Why would we NOT use such helpful tools?
For years there was only one book for the artist and now there’s tons of info
out there. It can be very confusing and hard to navigate. | will begin with
basics and show you what | use on a regular basis for my art.

Jan 5 The basics: All about FILES, TOOLS & basic navigation

Jan 12 Using history & layers, editing basics

Jan 19 Using clone, quick selection & skew tools

Jan 26 Using artistic filters & preparing artwork for print. (creating
collage canvases, & adding text to your artwork for giclée prints, cards
etc.)

PHOTO-IMAGING
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Files are like people you can measure F I L E I Y P E S
them 2 ways:

STl Sending See page 13 for TERMS and definitions. Most common image is
(6 MB megabites) JPEG.
o Vg i File/ Image Size —there are 2 ways to measure an
px pixels . .
‘ image like people...
'l.‘hey also have or extensions. . . . . . .
ing H_elg_ht - feeth_nc_hes ppi/dpi paper or screen dimensions for
2 viewing and printing

pdf

Weight — pounds and File Size -how much space it will take
on your hard drive) 13.9 MB or 149 Kb (below)

File size is proportional to the pixel dimensions of an image,
is partially determined by the file format, and it specifically refers to how much disk space your file
occupies, either on the hard drive, CD, DVD, Jump drive or other storage medium. Image files
normally range in sizes measured in Kilobytes (KB or K) and Megabytes (MB or M); extremely large
files may be measure in Gigabytes (GB). Images for print - larger file sizes, since higher resolution =
more data stored in the file. Images for Web or computer display - smaller file sizes. As a general rule
Web images should fall between 10 and 200K; images with larger file sizes will load more slowly, and
generally be too cumbersome Saving your images in. JPG or. GIF format will automatically compress
and reduce your file sizes significantly, so that you can fit more files onto a disk or attach more to an
email message,

Inserting images into presentations or other documents:

Resizing images on the screen after inserting them into your PowerPoint presentation or Word
document does *not* reduce the file size of that image; this only changes the dimensional display size
of the image in that document. Presentations and other documents that contain numerous images
can become very large in total cumulative file size. In order to keep such presentation and document
files at a reasonable size, you should appropriately resize your image files in an image editor before
inserting them into your final document.

Best Practices

Start Big: When in doubt about how you might end up using your images, opt for the highest
resolution possible. It is always better to start out with the most information possible, and then scale
down as necessary. If you start out with low resolution, you cannot get a higher resolution without
scanning or taking the picture again with higher resolution settings, and you may not get that chance.

How do you know how big your file is? This is what you need to know before you print, send in
email or post on website.
Printing and display of images-

For Printing: 150dpi, preferably 300dpi. Remember, dpi is “dots per inch”, and the more dots per
inch, the sharper and crisper your images will look on the printed page.

Computer Screen: Images intended primarily for display on a computer monitor (such as email
attachments or images on a Web page) really only need a 72ppi to 96ppi resolution, as that is
what computer monitors are capable of displaying. A higher resolution will not make your image
appear any better on the screen




THE IMAGE - Resolution & File Size

Units of Data Storage Computers (pc, laptop, netbook, tablet pc etc) store
information in the form of 1 and 0's in different types of storages such as memory
(ram), hard disks, usb drives, etc, to be processed by software. The most common unit
of data storage is expressed as byte which is 8 bits.

Data Measurement Chart
Data Measurement

Bit

Byte

Kilobyte (KB) 1,024 Bytes
Megabyte (MB) 1,024 Kilobytes
Gigabyte (GB) 1,024 Megabytes
Terabyte (TB) 1,024 Gigabytes
Petabyte (PB) 1,024 Terabytes
Exabyte (EB) 1,024 Petabytes

Resolution

Resolution of a digital image is related to how many of those little pixels (dots) you can cram into one
square inch of an image. Digital images are recorded as little square “pixels” of a single value A Mega

10 megapixel Camera
3648 pixels - =

)

00 pixels/inch resolutign
grint|size = 9.1"hx [12.3" w

Bikets

\Eﬁﬁh sr uarearg rggeqrt]s rc}mt—: ir;cr:h of
n anbsclt“iog pIxel ]n:‘?'%e X §Hb IXels |

wide ,000 pixels ac quare

Pixel is about ONE MILLION PIXELS
Each square above represents one square inch of print space. I've selected a resolution of 300
px/inch. How many inches wide will my print be? It will be 3648 divided by 300 = 12.2 inches

wide. How high will the print be? It will be 2736 divided by 300 = 9.1 inches high. Each square will
contain 300 pixels high by 300 pixels wide, or 90,000 little pixels in each square inch of the print (300
x 300). The photo printer will spray one little squirt of ink for each pixel. If you made the image
resolution 72 pix/inch, you'd only get 72 little spray squirts per inch. Not quite good enough for
printed material. 300 pix/inch resolution is.




What if | wanted a print 5” wide and still keep it at 300 pixels per inch resolution. You’d simply set the
width in pixels to 300 x 5 = 1,500 pixels wide, keeping the resolution at 300 px/inch. The height will
adjust accordingly if you constrain proportions.

Compression: Your camera can take images in several “compressions”. It's usually called “Super
Fine”, “Fine” and “normal”. What that does is save the picture with various jpg compressions
(described earlier). Super Fine has minimal compression but the kilobyte size of the image is

high. You memory card will hold fewer images on your camera, but the quality will be the highest
obtainable. Make sure your camera is set to Super Fine. Get a bigger memory card if you need to

store more pictures on your camera.

Raw Images: Some cameras can be set to take images in Raw format. A raw image has no pre-
defined settings applied to it. You can set white balance, file type (tiff or Jpg) and many other settings
AFTER you take the picture. You need special software to handle raw images (like the full blown
photoshop CS2 or greater). Raw images are the best when printing highest quality digital images is
paramount, but most midrange cameras cannot take Raw images. If your camera doesn’t have Raw
capabilities, that’s ok. Raw is generally used by professional photographers

How to RESIZE an image Open image in PS. Click FILE on top toolbar, then Save for
WEB, ten under IMAGE SIZE at bottom, set pixel width (800 W is good for websites and average

screen size, larger sizes for printing) Then click SAVE. Is usually preset to save as a Jpeg. | always
save a large version of the original file.

006 Save for Web & Devices (66.7%)

[Original | Optimized | 2-Up |4=Up. | Preset: [ JPEG High : -=
| JPEG 2

[ High +|  Quality: 60

G Rk

|
I Image Size
| w: 2656 px] Percent:| 100 %

Original: "IMG_5000Devin posteredges.jpg” JPEG 60 quality | | | H:[3156 |px =" Quality: | Biebic  ¢)

24M 1.422M Aoication Resampling method

264 sec @ 56.6 Kbps  ~=
Looping Options: [ Once

O@[ e [:)[ RrR-—- G- [ “Alpha: - Hex: - Index: — lofl

-~ B (| ’
| Device Central... | | Preview... | | @ @ E ( Cancel | | Done |




HOW to save in a different FORMAT

CLICK ON FILE, then SAVE AS. This will open your files, Choose type of file under FORMAT (Jpg,
Photoshop file or PDF) Name the File (I recommend adding clues if you have altered it in any way
such as ‘crop’ liten, sat, filter name and a name that makes it easy to find.) Choose a folder you want
to save it in and CLICK SAVE

Save As: | IMG_5000Devin posteredges.jpg B
l<al» (52 El lulu\ = v | | [ Stuff | might paint in 15 % | Q
FAVORITES (] Documents » [ 2013 work (2 Chloe Crabtree »
7 Music (3 Avid MediaFiles (3 2014 work » | [ Erika & Harvey Daniels  »
N (] Burn folde...tory Vatany » [] 2015 Work » [ Freedoms...ect 6-2014 *
) Pictures (] Desktop » [ 8882889 2011 stmts (3 Gabby
[l Movies (] Devin 0-7 Art Camp 2014.docx (] Hood photos » ]
3 Dropbox (23 Email & Address Book (3 Art supplies | order 1 IMG_4536JPG =
. B (3 Music ART VIDEO...ow-2.docx IMG_4537JPG
(&3 Mail Downloads 2 Pictures (3 check these videos IMG_4538.,PG i
[ Desktop (& video trans (L] CPS Newsletter & Events IMG_4539JPG B
# Applications (3 CPS Video Images & Misc » (i Inspiration I E
(22 CPS Videos » mack Pilkinton.jpg K
© Downloads (3 CPS Website Images (] Mandy Glazing Demo  + =
[ Documents (1] Debbie Stone (] Mirnics Best Shots
{2 Macintosh HD Denise's painting.jpg (1] Possibles »
£ Cnvme 5. ot 3 5ir T Lawre...zing demo || B
{2 Creative Cloud Files Photoshop small works »
sz ::A'se Document;format Stuff | might paint in 15 »
= »

[} EOS_DIGITAL A CompuServe GIF
Dicom

~ Photoshop EPS
IFF Format

Format: A 1]

| JPEG 2000
save: | I
Photoshop PDF
Photoshop 2.0
Photoshop Raw
Pixar

PNG

Portable Bit Map
Scitex CT

[ New Folder Loz

Photoshop DCS 1.0

Color:

Sydney Layne
Ukraine Project

el |

Menu Bar

(hover over tools for more options)

History & Layers

Be sure you have these 2 windows selected from the W!NDOW dropdown.

Analysis 30 View JUIEETH Help

Arrange >
Workspace >
Extensions

HISTORY

7 IMG_0766 SatL #1 choice.jpg

Character

v Clone Source

Layer Comps
v Layers
Masks

Measuremen
Navigator
Notes
Paragraph
Paths
Styles
Swatches
Tool Presets

Application Frame
v Application Bar
v Options.

v Tools

Vv IMG_9766 SatL #1 choice litensat.jpg
IMG_4543 4-9-15JPG

El Open

i3’ Quick Selection

{4’ Quick Selection

/ Quick Selection

AR EE

i@’ Quick Selection

History will hold your last 20
steps so that you can UNDO
or REDO. You can select the

step you want to return to.



LAYERS
One of the most important keys to learning and “

mastering Photoshop is using layers. (Nomal 2 Opacity[ 100x]"]

Why work on layers at all? : '

+ They do not destroy your original photo. 8 ok U/ @ Filk 100 ]

* You are working on top of or on copies of that photo. | T o e armiis e &l

* You will have more control. ad

* You can use blending modes to change the way 5 ) e
layers interact. ¥ Diop Shadow

+ You can change the opacity of any effects. % B R

* You will have or can add layer masks so that you can _|[® || T | program Chair - Mary Miller-McNutt email - ...
work selectively on your photo with any
adjustments you make. i ‘3 T Exhibit Dates: April 16 - May 14, 2015 Op...

* You can drag a layer into the trash (bottom right)

* You can turn layers on and off by clicking the eye on T |®|| T | wwwMonthavenansociety.org
left side of each layer. —

» Be sure you are on the layer you wish to adjust. I'm k ® | T | sumner County Convention & Visitors Cent..
always clicking and can’t figure out why it's not ===
working and realize | am not on the right layer. ® EI Laver 1

+ Double click on middle of the T (text layer) for an N
additional option box to add effects to your text. ol T hlonthaven A Sociely Saln
Be sure to Click on selection tool or T text e R

depending on whether you want to type or move
the text box.

EDITING TOOLS

Photoshop File

S5 E [

Marquee (hold MOVE
to choose different)
CROP Quick Selection
CLONE Eye Dropper
ERASER

Typing

Shapes

ZOOM (ctrl + or -)




CROPPING Images

Crop Tool
Click and
drag marquee
to area to
crop. Hover
over corner

for rotate tool.

Click and
rotate then
ENTER

Hit Escape to
cancel CROP

File Edit

Image Layer Select Filter Analysis 3D View

i Ps A v 333%xv [y &~

[300

| Cosarner <] [+

Grayscale
Ph h File Edit Layer Select Filter Analysis 3D View Window
y—Mode |

Dt B e

| wee[ || Adjustments

Auto Tone
Auto Contrast
Auto Color

2 GhrslonkSde]

Image Size...
Canvas Size...
Image Rotation

v

Crop
Trim...
Reveal All

Duplicate...
Apply Image...
Calculations...

Variables
Apply Data Set...

Bitmap
Grayscale
Duotone

Indexed Color...
v RGB Color
CMYK Color
Lab Color
Multichannel

v 8 Bits/Channel
16 Bits/Channel
32 Bits/Channel

Color Table...

Click on IMAGE, Mode & Grayscale

RGB Color is correct color match for Monitor
CMYK is correct color match for Printing
There are three basic types of color schemes:

. CMYK
. RGB
. PMS

CMYK, a four-color printing process that uses only cyan, magenta,
yellow & black inks, is primarily used for printing brochures, business
cards, posters & other paper-based products.

RGB, which uses mixtures of red, green & blue, is the preferred color
profile for digital devices and computer screens & appears much
brighter than CMYK colors.

Pantone Matching System (PMS) is often used to match colors in
fabrics like for t-shirts and other painted materials.



Adjusting the Image
Sepia, Hue, Saturation

The Hue/Saturation control allows us to change colors (hue), enrich or dull colors (saturation), lighten or darken colors
(lightness). The Levels or Curves controls are used more often for tonal

Hue is what most people call color. For example, a green car has the hue green. Saturation is how pure hue

is. Lightness refers to how bright, or not bright, something is. A light green car and a dark green car have two different
lightness values even though the hue is the same. In this example, both cars have the hue green, one has a lightness
value we call light and the other car has a lightness value we call dark.

Photoshop File Edit JIIFFTQ Layer Select Filter Analysis 3D View Window Hel

B viode > Sepia — Click Image, Mode & Hue/Saturation then slide

B el TR  Frightness/Convast.. &) [ saturation to desired level. If you want to change the overall
-—' evels... . .

DR .ot o | Exposire.. *»  color of the Sepia you can select Color Balance & adjust

2 " Auto Color %8 . . . . .
¥ | ' . | e oy 2 Saturation — I bump up the color in my images before painting
4 Grvssiae,  WHC | Coorbame. 4 sometimes using the Saturation tool.

£a Tim.. Chanmd Wi 8 Exposure — Use to adjust your photo in case of over or under
2r — mer 1 exposure (not enough or too much light) Brightness & Contrast
ERS Son e hdad | also works. Try both to see which gives better results.

0. % Selective Color...
5 | Shadows/Highlights...

o HDR Toning...

Desaturate Rix:4)

Match Color...
Replace Color...
Equalize

CLONE TOOL

Photoshop File Edit Image Layer Select Filter An Select the clone tool.
BEED - - 5 v sxe B ®v Choose a brush & size. Also choose Opacity
e 1™ —————— - \ — - | 0
L_," "“ é v‘ 1;8 v‘ @ Mode: | Normal A Opaciw:143‘)g v ,::{ A)

B Hold OPTION Key down and click on an
area you want to CLONE. Let go of Option
Hardness [ key and Click over area you want to paste
the clone image into. (It will also take a photo of the area

Size ‘ 158 px : w»

\H
&N
[ 1®
®
W ow

~l
|

| w
|
w
o

33

: .‘ ® ;.: U [ I around the clone so there is a limit)
ARl Rt b E You can drag the clone tool to ‘color’ the area.
o L «) | = » | w |9 |* ¥ A
O & S IERE 3L ] - s 27 | 3 | " A great way to cut out unwanted background
’)‘ T" P | %9 ‘1 17 | 23 | 36 | % 60 | 14 | 26 | or fix damaged old phOtOS.
k / 33 42 55 70 (127‘771??4 | 74 | 95 7{237.927 FUN to play Wlth!
.. L. W W | W ? Ak

| 55i]/m00:.) 75,




QUICK SELECTION TOOL

Great for trying different backgrounds. Simply drag around inside the area you want to select and
let go of mouse. You may have to try several times as it is not a fine tuned way of cutting out around
heads or objects. Area will be selected, then Click EDIT & Fill. The FILL box at bottom will appear.
Click on color (or black,white,gray) and the top box will appear. You can use the little circle to select
a color, drag the bar up and down to choose a new color family. Click inside the large box to select a
color or your eye dropper tool will appear when you move off the box so you can hover around your
current photo and select a color off the photo. Click to select. You can also use the BLUR TOOL
(next page) to fill this area.

_j Choose a color: L

\ Cancel \

| Add To Swatches |

<J  current - -
| Color Libraries |

JR
Oc:
B

| | Only Web Colors =)
#|3

— Contents
Use: | Color...

| Cancel |

Custom Pattern

— Blending

Mode: | Normal

Opacity: | 100 %

Preserve Transparency
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Blur & Gaussian Blur

Great for background in creating depth of field in photos taken with point and shoot, where everything
is crisp and in focus.

The central difference blur and G blur, depending on algorithm, is that Gaussian blur takes a
weighted average around the pixel, while "normal" blur just averages all the pixels in the radius of the
single pixel together. | think this latter "normal" blur is called box blur. http://blenderartists.org and
http://en.wikipedia.org/wiki/Gaussian_blur

Click on Filter (top) Choose Blur and Gaussian. Box on right will appear. Slide radius to determine
amount of blur. Click OK. You can select this option after selecting an area with the quick selection
tool.

elect T Analysis 3D View Window Help
= v Poster Edges ¥®F

|auto-€1  Convert for Smart Filters

;m Filter Gallery...
(RGB/8Y | ens Correction... (%R

Bisr  Liguify... o8X

Vanishing Point... X%V BE |
Gaussian Blur

Artistic

Average @
Brush Strokes > Blur [ Cancel
Distort > Blur More —_—
Noise > Box Blur... -
Pixelate > Gaussian Blur... =
Render > Lens Blur...
Sharpen > Motion Blur...
Sketch > Radial Blur...
Stylize > Shape Blur...
Texture > Smart Blur...
Video > Surface Blur...
Other > ST,

Radius: |26.0 pixels

v

Digimarc

Browse Filters Online...
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ARTISTIC FILTERS

After you select a filter (bottom left) the box on right will appear. You can select other filters in the
middle and each has slider adjustments to vary edges and other details. | use poster edges &
watercolor. But its’ fun to experiment. Check out http://tv.adobe.com/watch/photoshop-elements-12-
feature-tour/new-filter-effects-in-photoshop-elements-12/

®_ Adobe Photoshop Elements Editor_File_Edit_Image _Enhance _Layer _Select

View Window _Help ) (=} (Charged) TueJun 12 12:41PM Q

Graphic Novel ®F
Caanl Quick  Guic Filter Gallery... —
VIEW x © PX_20120310_1324)_edited-1.jpg @ 77.8% (Background copy 3, RGB/8) * l Correct Camera Distortion... Je.oa &% g =
QR Selustments Normal Opacity: [100%[ ~ |
SELECT Artistic
=T Blur
il Brush Strokes
e N Distort Background copy 2
ENHANCE :i:les\:(e g
i =3 Background copy
0
: 3 8as Relief... 1 .
& & tylize Chalk & Charcoal... * Background -8
Texture »  Charcaal...
¢ & Other »  Chrome...
DRAW Comic...
7 Digimarc »  Conté Crayon...
4 Nik Software Graphic Novel...
Graphic Pen...
L Halftone Pattern...
s * Note Paper...
% % pen and Ink...
d B Photocopy...
Plaster...
obe Reticulation..
= Stamp...
Torn Edges...

Water Paper...

!

Photo Bin " Tool Options * Undo _ Redo _ Rotate _Layout Organizer

S x + % B

Layers _Effects Graphics Favorites More

Elements 12

le Layer Select JHITTH Analysis 3D View

Window Help

v [Ev =~ Poster Edges ®F

|
Sample All Layers UAuw-EA: Convert for Smart Filters

- ~  Filter Gallery...
"s'}c”“ Lens Correction...  0'%R
Liquify... 08X
Vanishing Point... X3V = . o=
Artistic 3l Colored Pencil... el
Blur > Cutout... fostr e -
Brush Strokes > Dry Brush... ohimser ¢
Distort > Film Crain...
Noise > Fresco...
Pixelate > Neon Glow...
Render > Paint Daubs...
Sharpen > Palette Knife...
Sketch > Plastic Wrap...
Stylize > Poster Edges...
Texture > Rough Pastels...
Video > Smudge Stick...
Other > Sponge...
Underpainting...
Digimarc > Watercolor...
Browse Filters Online...

Photoshop CS5
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TERMS:

2560 x 1920 pixels = 5 Megapixels ... and so on

1280 x 960 pixels = 1 Megapixel

1600 x 1200 pixels = 2 Megapixels

2048 x 1536 pixels = 3 Megapixels

2272 x 1704 pixels = 4 Megapixels

Bit - The smallest unit of memory; a contraction from 'binary' and 'digit'. Binary digits are 0 and 1, also known
as ons and offs.

BMP - Bit Mapped graphic file format popular with Windows computers. This is an uncompressed file format
like TIFF.

by Megapixels. You multiply the horizontal resolution by the vertical resolution to get the total pixel count:
CMYK - Cyan, Magenta, Yellow, black; These are the printer colors used to create color prints.

Codec - Compresses information so that it can be sent across a network faster, and decompresses
information received via the network.

DPI - Dots per Inch. A measurement value used to describe either the resolution of a display screen or the
output resolution of a printer.

Full Bleed - Printing term used when an image or inked area extends to the edge of all four sides of the
printed piece. Better known as "borderless" in today's world of inkjet photo printers.

JPEG - Joint Photographic Experts Group - The name of the committee that designed the standard image
compression algorithm. JPEG is designed for compressing either full-color or grey-scale digital images of
"natural”, real-world scenes.

MB - Megabyte, memory term meaning 1024 Kilobytes. Formatting memory cards

Megapixel - CCD resolution of one million pixels. Digital cameras are commonly rated

MPEG - Motion JPEG movie file. "Movie clip"

PDF is also an abbreviation for the Netware Printer Definition File. PDF (Portable Document Format) is a file
format that has captured all the elements of a printed document as an electronic image that you can view,
navigate, print, or forward to someone else.

Pixels These are the tiny color units that comprise a digital image. They are also used to measure sharpness
of a digital picture in a term known as mega-pixels. The higher the mega-pixel rating the camera has the
sharper the images it will take.

RAW — unprocessed, NO compression, large file must have program to open it. Reference Links:
http://www.zuberphotographics.com/content/photoshop

Resize - Usually means to take a large image and downsize it to a smaller one. Most graphic viewing and
editing programs offer a Resize option for this purpose.

RGB This refers to the way computers create colors using differing amounts of three colors; red, green, blue.
The digital video compression standard agreed upon by the Motion Picture Expert Group

TIFF - Tagged Image File Format - An uncompressed image file format that is lossless and produces no
artifacts as is common with other image formats such as JPG.

Underexposure - A picture that appears too dark because insufficient light was delivered to the imaging
system. Opposite of overexposure.

URL - Abbreviation of Uniform Resource Locator (URL) it is the global address of documents and other
resources on the World Wide Web

USB - Universal Serial Bus - the data I/O port on most digicams and found on modern PC and Mac computers.
Faster than the serial port. Up to 12Mb/s with v1.1 interfaces.

RASTER vs VECTOR
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Raster vs. Vector images — what's the difference?
Stickermule.com.

Posted by Jeremy Wick

Raster images are made up of a bunch of tiny pixels, while vector images are made from
mathematical paths.

What is a raster image?

A raster image is a term in computer graphics and digital photography. A raster, also called a bitmap
image, represents a rectangular grid of pixels.

They are viewable using a bitmapped display or another medium.
How do you increase the size of a raster image?
Let's pretend you have a raster image that is 300 x 300.

While it's easy to make an image smaller, increasing the size usually means decreasing the
resolution. Although with Al tools, it is possible to increase your artwork resolution.

What is a vector image?

A vector image or graphic is a type of image defined on a plane, connected by lines and curves.
They form shapes based on mathematical equations. And because of this, if you zoom in or out, the
lines, curves, or points always remain smooth.

What are the uses of vector graphics?

Vector graphics are used by artists who are creating illustrations, logos, and other designs that are

going to be printed on big surfaces. This is why a lot of designers prefer to convert their images to
vector before printing them out.

How do you increase the size of a vector image?
Now let’s pretend you have a vector image that is 300 x 300.

Because a vector image is made up of mathematical paths, you can increase the size of the image
as much as you want and it would never decrease in quality. You could literally increase the size to 3
million x 3 million and all the details would still look sharp (assuming your computer could handle a
file that big).

This difference usually makes vector images a superior option, especially when it comes to print.
However, there are times when using raster images might be your best option. For example,
photographs are always raster images. Converting a photograph to a vector image is possible, but
will usually result in a drop in detail.

14



If you plan on using a logo, text, or illustration for print, we recommend tracking down a vector version of the

artwork if possible. Otherwise, try to get the highest resolution version of the artwork possible.

What are the common raster file types?
e .png

e .jpgor.jpeg
o gif

o tif

e .psd

What are the popular raster-based image editors?
e Adobe Photoshop

e GIMP
e Photo-paint

What are the common vector file types?
e .eps

o i

o .pdf

e SVg

o .sketch

What are the popular vector-based image editors?
¢ Adobe lllustrator

e Sketch

15



What is a bitmap? Figma.com

A bitmap describes a type of image that web-users encounter all the time without realizing
it. Basically, it's a grid where each individual square is a pixel that contains color
information. The key characteristics are the number of pixels (or squares in the grid), and
the amount of information in each grid square (pixel). Bitmaps and raster images are
interchangeable terms that refer to the same concept: a grid full of pixels that—when
arranged densely enough—form a clear image.

Like raster graphics, bitmaps are made up of individual, tiny points that blend together to
form a unified image. Unlike vector graphics, which are infinitely scalable, you can’t stretch
or enlarge them without compromising the quality.

How It's Created and Stored

When you break down an image into a grid made of thousands of squares, you get a
bitmap. Each square in that grid holds a little bit of color data and displays (or doesn’t
display) a color based on that data. Like a color-by-numbers sheet, a key correlates each
point’s data assignment with a color. In the end, it provides the literal map that tells you
what that image should look like once it’s put together.

-
i_f_l
D
Y
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the cunplo guudo to

HILE TYPES

PHOTOSHOP FILE

Uncompressed, layered master file that can be
modified in Photoshop. Typically contains
raster graphics, but supports vectors too.

ILLUSTRATOR FILE

Scalable, vector-based master file that can be
modified in lllustrator. Can be imported into
Photoshop with limited functionality.

UNIVERSAL GRAPHICS FILE
Typically contains scalable vector graphics and
can be modified in lllustrator. Can be imported
into Photoshop with limited functionality.

RASTER GRAPHICS FILE

Uncompressed raster graphics format that
supports transparent backgrounds. Can be
used in any software.

RASTER GRAPHICS FILE
Compressed image format for reduced file
size while maintaining high image quality.
Transparency is not supported.

OPENTYPE FONT FILE

Font format supporting features like stylistic
and contextual alternates, ligatures, swashes,
and much more.

TRUETYPE FONT FILE

Font format with basic character support.
Some programs, like those used for vinyl
cutting, only support TrueType fonts.

COMPRESSED ARCHIVE

Contains files/folders in a compressed format
for quicker downloads. Can be extracted using
default operating system software.
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